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Overview of Showbiz BudgetingTM                                                                                             
 
Showbiz Budgeting is an advanced cross-platform application for creating and actualizing budgets 
in a wide variety of formats. Budgets can be created using one of the many supplied Templates, or 
new Templates can be created from scratch by the user. Showbiz Budgeting's advanced features 
include: 
 
   
    • Flexible Formats - Several different Category/Section types and an flexible Summary provide 
support for a wide variety of complex budget forms including AICP, AICE, CICP, motion picture, 
television and many others. 
  
    • Phases - You can budget and actualize distinct job Phases and show each Phase as well as 
the it’s grand total in it's own column.  
 
    • Views - See only the Phases and columns you want to see. Any View can be displayed or 
printed.  
 
    • Flexible Entry - Amounts can be entered at the Account level or at the Detail level.  Unlimited 
Detail items can be entered and displayed for each Account and Phase.  
 
    • Fringes - store union and payroll Fringe rates by name and assign single or multiple Fringes to 
any Account or Detail item.  
 
    • Globals - store numbers by name for quick replacement throughout your budget as 
circumstances change over the course of your production.  
 
    • Automatic Overtime - For short form projects, crew days can be expressed as hours per day 
(i.e., two 12 hour days and three 14 hour days) and OT will be calculated automatically according 
to the assigned Fringes.  
 
    • Foreign currency support - Store up to ten Currencies in each budget. You can switch 
Currencies at any time and then continue working in the new Currency.  
 
    • Actualization - A full range of actualization tools allows you to track expenses during and after 
production.  Support is included for Payroll, Purchase Orders and Petty Cash. Payrolls can be 
imported directly from a payroll service.  
 
    • Reporting - In addition to budget printouts, Showbiz Budgeting offers a variety of reports 
including Detail reports, Purchase Order reports, and Petty Cash reports. You can create report 
Views which customize the data displayed on your reports and use filtering options to specify the 
most vital data.  
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Installing Showbiz Budgeting 
  
 

Windows: 

 

1. Insert the Showbiz Budgeting disk into your computer’s CD-ROM drive and the Installer should 

start automatically. If it doesn't, double-click on the Showbiz Budgeting WIN .exe file  

 

2. If you've downloaded the Installer file to your PC, double-click on it’s icon to run the Installer. 

 

3. Follow the prompts as they guide you through the installation process. 

 

4. Following installation, Showbiz Budgeting features a free trial period of 30 days. To permanently 

activate the application at any time, click on the Register button when the trial message appears 

after startup. Submit the Installation ID displayed in the software registration window and the disk 

serial number online at http://www.media-services.com/unlockme.html. Once you've entered all the 

required information, click the Submit Form button. We will respond with your unique unlock code 

and instructions on using it. 

 

 

Mac: 

 

1. Insert the Showbiz Budgeting disk into your CD-ROM drive, then double-click the CD when it 

appears on your desktop. 

 

2. Double-click the Showbiz Budgeting MAC.zip file. It will extract a Showbiz Budgeting folder on 

your desktop. 

 

3. Drag the folder to your Applications or your preferred location on your computer’s hard drive. 

 

4. Double-click the Showbiz Budgeting application to start the program. 

 

5. Following installation, Showbiz Budgeting features a free trial period of 30 days. To permanently 

activate the application at any time, click on the Register button when the trial message appears 

after startup. Submit the Installation ID displayed in the software registration window and the disk 

serial number online at http://www.media-services.com/unlockme.html. Once you've entered all the 

required information, click the Submit Form button. We will respond with your unique unlock code 

and instructions on using it. 
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Registering Showbiz Budgeting 
 

Visit this web page: 

 

http://www.media-services.com/unlockme.html 

 

Provide all the requested information and click the 'Submit' button. 

 

We will respond with your unique code and instructions on using it within two business days. 
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Quick Start 
 
Before printing your first report, make sure your printer is set up.  Click File, then Page Setup, 
select a report and then click the Printer button.  Make sure the printer Name which is displayed is 
the one which you plan to use.  Use the printer name dropdown list to change the printer selection 
if need be, then click the OK button. 
 
 
Important Key commands: 
 
Column Width Adjustments - When widening a column using the mouse, press the Option key 
first (Alt key on PC) and all columns to the right will be adjusted simultaneously.  If you hold the 
Shift key and use your mouse, all columns to the left will be adjusted at the same time. 
 
 
Edit Detail Pane - When entering Detail Items, note that using the Enter key will close the Edit 
Detail window. Hold the Option key (Alt key on PC) and the OK button label on the Edit Detail 
window will change to Next.  Clicking on it will automatically enter the current Detail and then 
display a new, blank Edit Detail window. 
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Your First AICP Bid   
 

1. Start Showbiz Budgeting   
 

Double-click on the Showbiz Budgeting program icon on your desktop:   
 

 

2. Create a new bid  
 
Click on the File menu and select New.  The Master Templates folder should open by default. If it 
does not, use the appropriate controls to locate it within the Showbiz Budgeting program folder.  
  

 
 
Select the AICP template with which you want to start your new file, such as a standard AICP 
Master, Music Video or AICE.  If you don’t see any Templates listed in this window, try changing 
the Files of type to “All Types [*.*]” – all template files end with the extension .mbt. Click on the file 
name to select it and then click on the Open button. The blank file will open in the main window, 

ready for your input. Click the Save icon  to give your new file a name and retain your work.  
 
 

3. Create your Title Page 
 
Click on the Titles tab, which is the one at the far left of the program window. Fill in your company 
info using the mouse, arrow keys or the Tab key to move between fields. Then click on the Save 
Data button, choose a folder in which to save this info and click the Save button. Budgeting will 
use this same info on any future bids when you select the Load Data button on the Titles tab!  The 

Tool button  displays text and layout tools such as font formats and field locks which can be 
used to change or protect the appearance of the text you enter on the Titles page. 
 
 
 



June 3, 2010 v8.72 

 

8 

4. Establish Fringes     
 
Click on the Tools menu and then select Fringe Manager. The Fringe Manager window will be 
displayed: 
 

 
 
 

Click on the Add button  to create a new Fringe in  
the Edit Fringes window. (open one of the demo files and  
repeat these steps if you want to see examples)   When  
creating a new Fringe, you must enter a Code and Name  
in the Edit Fringes window.  An example of a Code and a  
Name might be “NYU” for “New York Union”.  Click on the  
Tab key to navigate to the next fields to enter Percentage  
or Per Unit rates.  Next, tab to the Overtime section to  
enter your overtime pay structure.  For example, you could  
enter 1.5 after 10 hours, 2 after 12 hours and 3 after 14  
hours.  This would give you time and a half after 10 hours,  
double time after 12 hours and triple time after 14 hours.   
Showbiz Budgeting can now accurately calculate overtime  
pay based on the length of the days worked.    
 
 
 
 
 
5. Enter the shoot schedule 
  
You can create the crew's schedule quickly by using our powerful Globals feature.  Click on the 
Tools option from the main menu and then click on Globals.  First enter a simple Code in the 
Code field (“S” for “shoot”, for instance) and a Description of what the code stands for.  Then 
enter the number of days of each length you are bidding. For example, two 8 hour days and three 
12 hour days.   
 

 

 



June 3, 2010 v8.72 

 

9 

6. Complete section A  
  
Click on the Budget tab to display the AICP form. Note that the dropdown menu on this tab is used 
to display each of the alphabetical Categories in the Template.  
 

 
 
Use the Tab key or arrow keys to move between cells and enter the number of prep/wrap days of 
each length for each crew member. Remember that you can use the Globals as a quick way to 
enter a number of different length work days. If you want to change any default rate, just move to 
the Rate column and enter a new amount. Note that the section totals and grand total are 
immediately updated on the status line at the bottom of Showbiz Budgeting's main window. Click 
on the Summary tab to see the accumulating totals for the section as you enter new costs.   

 
7. Complete section B 
 
Move to section B using the dropdown menu at the top of the Budget tab. In section B, you can 
use the schedule you defined in Step 5.  Move to the Global column and enter the first letter of the 
schedule Code you created in the Globals window.  Showbiz Budgeting fills in the schedule of 
days and hours automatically.  If any crew members will work different schedules, the number of 
days can be changed in the Hours per Day columns.  To remove a Global from the current line, 
highlight its’ Code in the Globals column and click the Space bar on your keyboard.  Note that 
Rates do not automatically copy from section A.  You might want to highlight a selection of 
lines and copy their Rates from section A to B.  Alternatively, you can use the Sync Groups 
function available from the Category menu to automatically fill in the Account Name, Fringes and 
Rates from one section to another. 

 
8. Complete sections C through O  
 
Costs in sections C through O are considered flat dollar amounts.  Enter the dollar amounts into 
each line or click on the Detail button if you wish to enter these as Details which will automatically 
be added to each section displayed in the Summary tab.   
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9. Edit the Summary Page  
 
Click on the Summary tab. Note that lines displayed with a gray highlight in the leftmost column are 
Contract Fees: costs which are calculated additional to the goods, labor and services in the 
various budget sections. These are typically insurance charges, overages and production fees.  
Double click on highlighted area in the leftmost column and the line’s edit window will be displayed: 
 

 
 
You can enter either flat figures or percentages for both estimated and actual costs in this window.  
To exit, click on the Cancel or OK buttons.   
  
You can add a new Contract Fee line by highlighting a line in the Summary tab and then using the 
right-click menu to select Add. When the new line’s edit window is displayed, use the Type 
dropdown to select Contract Fee. Additional to assigning a Code and display Text, you must 
select items for a percentage calculation to use as its’ basis.   
 

 
 
Summary tab lines which do not display a gray highlight in the leftmost column can also be edited 
using the right-click menu or the Edit menu. Double-clicking on these lines will automatically open 
the Budget tab display of the Accounts contained in these Summaries.   
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10. Print your Budget and Actuals Reports 
 

Click on File menu and then select Print or click on the Print icon on the tool bar   
to open the Print window.  
 
You’ll see that Budgeting displays a list of all the AICP budget sections in your file. Use the mouse 
to check the box next to each section you want to print.   
 
 

 
 
 
Click on the Preview button below the Print button.   
 
 

 
 
 
Use the Next / Previous Page buttons or the dropdown menu to browse through your completed 
AICP bid.  Click on the Print button to send your report to the most recently selected printer.  All 
reports can be saved as PDFs. Windows users will need to insure that a PDF writing program such 
as Acrobat or PrimoPDF is installed. It will be displayed in the list of available printers. Mac users 
will need to choose the Convert to PDF option available from the Print Preview window for each 
report. 
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Menu Commands         
 
 
 File Menu 
   

 
 
    • New - Creates a new, untitled budget file based on a Template. Showbiz Budgeting Template    
      files have the extension ".mbt"   
    • Open - Opens a previously saved budget file. Showbiz Budgeting files have the extension  
      ".mbb"   
    • Save - Saves the currently open budget in a folder. If the budget is new and “untitled”, you will  
       be prompted to assign a new name, otherwise it will overwrite any other “untitled” file.   
    • Save As... - Use this command to save the current budget file under a new name, leaving the  
      current file unchanged.   
    • Close - Closes the current budget.  
    • Import - Imports information from another source file. Use this command to import payroll data  
      from a payroll service or to create a budget Template from other applications.   
    • Export - Exports information to other applications.   
    • Convert PC Files - Budgets and Templates created with Showbiz Budgeting PC version may  
      not be recognized by the Mac Finder and thus fail to appear in the New and Open file selection  
      window. These files can be made recognizable to the Mac Finder by choosing this command.   
    • Print - Displays the Print dialog, which contains tabs that determine what will be printed.    
    • Page Setup - Sets up Showbiz Budgeting for the active printer. You should select this  
      command when you choose a new printer.   
    • Save as Template - Saves the current budget as a Template, with “.mbt” file extension.   
    • Create Template - Use this command when you want to create a new budget format from  
      scratch.  
    • Vendor Database - Use this command to edit, open or create a Vendor Database.   
    • Quit/Exit - Closes the application.   
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Menu Commands 
  
 
Category Menu 
  

 
  

• Edit - Opens the Category Edit Window. Use this command for editing the current 
Category's Code, Name or Type.  

  
• Delete – Removes the currently selected Category from the budget file. 

 
• Add Account – Creates a new Account at the top of the list of Accounts within the currently 

selected Category.  You will be prompted to enter a new Account Code and Name. 
 
• Insert Account – Creates a new Account above the currently selected Account.  You will be 

prompted to enter a new Account Code and Name. 
 

• Delete Account – Removes the currently selected Account. 
 
• Sync Groups – Opens a dialogue box which allows you to specify AICP Template sections 

between which information can be automatically copied.  For instance, the Account Names, 
Fringe selections and Rates from Section A may be assigned to Section B if desired.  
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Menu Commands 
  
 
 Phase Menu 
   

 
 
    • Phase Manager - Displays the Phase Manager window. Use this command to add, edit, delete 
or delete Phases in the current budget or to re-arrange the order in which they are displayed in the 
Budget tab (use the Up and Down buttons in the window to change the display order). 
 
    • Copy - To copy the contents of another Phase into the current Phase.  Click in the Phase you 
wish to copy to, then select this command.  You will be prompted to select the source Phase.   
 
    • Paste – 
 
    • Clear - Clears the contents of the currently selected Phase.  Make sure to click in the desired 
Phase to activate it before selecting this command.   
 
    • Select Color - Allows you to select the color used in displaying the current Phase on your 
computer screen.  Click in the desired Phase before selecting this command.  Note: You can 
adjust the overall intensity of all Phase colors by selecting Tools/Preferences/Application..  
  
    • Lock - Allows you to prevent accidental input to any Phase.  For instance, you can lock the 
estimated side of a budget while actualizing.   
 
Note that columns within a Phase may be re-ordered by dragging and dropping them.  Use the left 
mouse button to click on the column header and drag the column to its new position within the 
Phase.  Columns cannot be dragged out of the Phase to which they belong, nor can they be 
dragged when the Phase is isolated (see:  View Menu for details on isolating Phases).   
 
Phases may only be re-ordered within the Budget tab by using the Phase Manager.    
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Menu Commands 
  
 
Tools Menu 
   

 
 
    •  Currency - Opens the Currency Window. Use this command to edit a foreign Currency's Rate, 
Unit or Symbol or to set the active budget's display Currency.  
  
    •  Globals - Opens the Globals Window.  Globals allow you to define commonly used numerical 
values by name.  Use this command to add, edit or delete a Global. 
  
    •  Fringe Manager - Opens the Fringe Manager window.  Fringes are most commonly used to 
add union fringe benefits to labor charges, but they also are used for defining overtime setups 
when your budget contains one or more 'Auto OT' crew categories. Use this command when you 
want to add, edit or delete a Fringe. 
   
    •  Assign Fringes - Opens the Assign Fringes window.  Use this command when you need to 
make complex Fringe assignments involving multiple Fringes.   
 
    •  Accumulators - Opens the Accumulator window. Accumulators allow you to keep up to three 
subtotals of selected Accounts for use on the Summary page. Common uses are markup, 
discounts and sales tax.  To use any Accumulator, you must first display it's column using the View 
Manager.   
 
    •  Sub-Groups – Opens the Sub-Groups window. (see Sub-Groups for details on use). 
 
    •  Breakout - Opens the Breakout Window. Breakouts are used on a Detail level only.  
Generally used during actualization to keep a separate breakout for insurance claims, overages, 
weather days etc.   
 
    •  Formulas - Allows you to define the current Account subtotal as percentage of one or more 
Accounts.  Useful for markups, surcharges, taxes, etc.   
 
    •  Preferences - Opens the Preferences window in Windows and Mac Classic. For Mac OS X, 
use the Showbiz Budgeting/Preferences menu.   
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Menu Commands 
  
 
View Menu 
   

 
 
    • View Manager - Provides two levels of protection to the columns in the current View. Very 
useful for preventing accidental changes to Views used for printing.  When Views are locked, the 
cursor will not change as it passes between column headers, as the resizing function is now 
disabled..   
    • Lock - Provides two levels of protection to the columns in the current View. Very useful for 
preventing accidental changes to Views used for printing.  When Views are locked, the cursor will 
not change as it passes between column headers, as the resizing function is now disabled..   
    • Show Print Ruler - Use this command when resizing columns in Views you intend to print 
from.  When the print ruler is displayed, the main budget grid will resize and will use the currently 
selected printing font.  This provides a more reliable indication of text-fit within the columns.  You 
should hide the print ruler for normal input.   
    • Default Column Widths - Use this command to return all columns to their default widths.  
NOTE: This command will only affect columns for the current Category Type.   
    • Isolate Phase - Use this command to isolate or "zoom in" on a particular Phase.  Only one 
Phase can be isolated at a time.  When a Phase is isolated, it is uncollapsed (all available columns 
are displayed), and all other Phases are hidden.  Phase column headers will display in a darker 
color to indicate isolation mode. You can toggle isolation mode using the ~ key (Esc key if using a 
PC).   
    • Collapse Phase - Toggles collapsed mode in the selected Phase.  When a Phase is 
collapsed, only it's Total column will be displayed.  You can toggle this mode using the Shift + ~ 
key combination (Shift + Esc if using a PC).   
    • Show - Allows you to conveniently show or hide any Phase.  This has the same effect as 
clicking the checkbox next to the Phase's name in the View Manager.   
    • Show Variance - Shows or hides the Variance column.  NOTE: Variance columns are only 
available when only two Phases are being displayed.  Variance is calculated according to the 
Phase display order from left to right.  Changing the Phase order will affect the Variance 
calculation.   
    • Show Var %  - Shows or hides the Variance percentage column.   
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Menu Commands 
  
 
Window Menu 
 
Click the Window menu to see a list of the currently open budget files and use it to toggle between 
these in the main program window. 
 
 
 
Help Menu 
 
    • Showbiz Budgeting Help - Use this command to open the programs’ online Help file and 
choose among the Contents, Index and Search options to quickly find the info you need. 
 
     • About Showbiz Budgeting (Windows) – Clicking on this will display the version and build 
number of the program you presently have open. Clicking the License Agreement button will 
display the terms of use you agreed to upon installing and registering the program.   
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The Main Tab Panel 
 

 
 
The Titles Tab  
 
Using simple spreadsheet-like functions, Showbiz Budgeting's Titles area allows you to create 
relevant production information for a wide range of budget formats.  
 
Note: Most of the font and layout editing functions are disabled when the editing tool buttons are 
hidden.  Clicking on the “wrench” button will show or hide the tools. It is recommended that you 
keep the editing tools hidden to prevent accidental changes.  
 
To enter information into an existing budget form: 
 
Click or use arrow and tab keys to navigate to the desired cell, then type.  To edit existing data in a 
cell, double-click in the cell to enter edit mode.  Gray text in a cell indicates that the cell is protected 
to avoid accidental changes.  
 
Loading and saving data to disk: 
 
Data you use often, such as company names and addresses can be saved to disk for easy access 
later.  Remember though, that data must be saved and loaded into similar Titles layouts, otherwise 
the results may not be what you expect. 
 
To save data, use your mouse to select the range of cells, then click on the Save Data button. The 
data will be saved to the filename and location you specify. 
 
To load data, highlight the top-left cell where the data should begin, then click the Load Data 
button.  Select a file containing saved data, then click the OK button..  
  
Using the Editing Tools 
 
Routine input to the Titles area should performed with the editing tools hidden. This serves to 
protect the Titles layout from inadvertent changes.  Column-sizing is disabled while the tools are 
hidden.  When you need to change the layout, clicking the wrench button will show the editing tools 
and activate column-sizing.  
 
Merge-and-center Tool - This tool will center text across a number of columns. Use your pointing 
device to highlight the range of cells to span, then click the tool.  If you want a different alignment, 
click on the alignment tool while the range is still highlighted.  The merged area will now act as a 
single cell.  To return the range to normal, first highlight the range, then click the merge tool again.  
 
 Border Tool - Toggles the border lines around a selected range of cells.  
 
 Vertical Line Tool - Shows or hides the vertical lines within a selected range of cells.  
 
 Horizontal Line Tool - Shows or hides the horizontal lines within a selected range of cells.  
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 Protect Tool - Toggles the protected state of a selected range of cells. Protected cells do not 
allow input and their text is displayed in gray.  
  
Resizing Columns 
 
Column sizing is activated only when the editing tools are displayed.  
 
Adding and Deleting Rows and Columns 
 
 Rows and columns can be added, inserted or deleted using the Edit menu. 
 
Add - Adds rows at the bottom or columns at the right. 
 
Cut - Deletes the selected range of rows or columns. 
 
Insert - Inserts rows above the highlighted row or columns to the left of the highlighted column. 
  
Inserting Page Breaks 
 
Page breaks can be inserted by typing the letters "pg" enclosed in html tag brackets (i.e., you 
would type shift-comma, pg, shift-period) into the left-most column at the row where you want the 
page break to occur.  This feature allows you to create multi-page Titles.  
    
Note:  use the dropdown menu at the upper left to Add, Delete or Rename a set of Titles or to 
select another set of Titles which you have previously created. 
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The Main Tab Panel 
 
 
The Comments Tab 
 
Comments can be entered in the Comments editing field using the simple word-processor like 
controls.  Comments will be printed on the Titles page after the Summary. 
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The Main Tab Panel 
 
 
The Summary Tab 
 
You can always view the current budget Summary by clicking on the Summary tab.  The Summary 
is flexible enough to support a wide range of forms, even AICP where certain rows may summarize 
more than one Category/section.  
  
 Basic Operation 
   
    • Phases and Variance columns are displayed as defined in the current View.  
    • You can select the current View by selecting one from the View pulldown menu located above 
the Summary list.  
    • Values or percentages for contract fees like markups and insurance can be entered by clicking 
the button that displays in the leftmost column.  
    • Column widths can be adjusted with the mouse only when the current View is unlocked.  Use 
the View/Lock command to change this setting.  
    • While viewing the Summary, double-clicking on a row will jump to that Category on the Budget 
tab.  
    • You can edit the text in any row using the Edit menu.  
  
 Advanced Operation 
 
The following topics are relevant if you are creating a new budget Template or you wish to change 
the Summary in an existing budget form. 
  
Summary Row Types 
 
 There are five types of Summary Rows available: 
   
    • Category Total - The row displays the total of one or more budget Categories.  The text need 
not be the same as the Category name.  
    • Contract Fee - Use this type to add fees like markups, insurance, contingencies, etc which are 
based on a percentage of one or more selectable values.  
    • Level Break - Displays the total of the Summary rows following the previous Level Break, then 
resets the Level Break amount to zero.   
    • Level Recap - Same as the Level Break, but does not reset the Level amount to zero.  
    • Running Total - Displays the current running total of the Summary rows at this point in the 
Summary.  
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Adding Summary Rows 
 
 Choose Edit/Add from the main menu to add a new row at the bottom of the Summary list.  Use 
Edit/Insert to add an item above the highlighted row.  You can edit the currently highlighted 
Summary Row by choosing Edit/Edit.  
 
 Editing Summary Rows in the Summary Edit Window  
 
 Use this window to adjust the properties of a Summary Row.  If you are editing a Category total 
row, you can select which Categories will be included by checking them in the listbox.  To select 
from all available Categories even though they are not currently selected, click in the Show All 
check box.  Note that a Category total can only be included in one Category row. You can create 
or delete Categories by clicking the New or Delete buttons. Checking the GT (“Grant Total”) 
checkbox will mark this Summary Row's values for display in the Grand Total fields at the lower 
right of the Budget document window. 
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The Main Tab Panel 
 
 
The Budget Tab 
 
The Budget Tab is the main budget display and data entry area.  It consists of two main elements: 
the Budget Grid and the Detail List.  
  
The Budget Grid 
 
The Budget Grid is always visible.  How it is displayed is controlled by the View settings.  You can 
select the a View using the Views pulldown menu located above the grid.  (see also: Views) 
 
Most columns allow direct data entry.  To enter a value, simply highlight the cell by clicking in it, or 
by using the arrow keys, then type the data.  Note that some columns display data derived from 
other locations and cannot be edited directly. Columns such as this are shaded. 
  
Budget Grid Column types and data entry 
 
Which columns are visible in each Category is dependent on the Category Type and View settings.  
 
Below is a general overview of editing features for certain column types.  Some column types may 
not be relevant to the budget form you are using.  Note that many of the column header labels 
(such as Fringes, Globals, Qty, Unit and Rate) can be edited by double-clicking on them and then 
changing the text displayed in the form which appears.  Click the OK button to apply your change 
or the Cancel button to discard it.  
 
    • Code - To edit a Code, double click on the Code you want to change.  
    • Account - Account names can be edited directly in the cell or you can double-click on the 
name to open the Account Edit window  
    • Accumulators - Accumulator columns are visible when optional Accumulator support is 
selected in the Category Edit Window.  The column header for these columns will display the 
Accumulator Code.  The space bar or the Delete key will clear the cell, while pressing any other 
key will "set" the Accumulator and display a bullet in the cell.  (see also: Accumulators)  
    •  Fringes - Fringe columns are visible only when optional Fringe support is selected in the 
Category Edit Window.  This column allows you to assign Fringes to the current Account.  To 
assign a Fringe, enter the first letter of the Fringe Code.  You may also Ctrl-click (right-click in PC). 
Multiple Fringes may be assigned to each Account by double-clicking, to open The Fringe 
Assignment Window.  (see also: Fringes)  
    •  Global - Only visible in Crew (Auto OT) Categories. This column allows you to use Global 
values to schedule your crew. You can set up Globals by clicking the Globals icon on the toolbar. 
To assign a Global, enter the first letter of the Global Code you wish to assign. You may also Ctrl-
click (right-click in PC) to select from a popup menu.  (see also: Globals)  
    • Qty - Quantity values can be entered directly in the cell. You may also use any defined Global 
value by typing the first letter of its Code, or Ctrl-clicking (right-click in PC) to select from a popup 
menu.  
    • 8h-16h - Only Auto OT Crew type sections contain these columns. Each column represents a 
different day length. For instance, entering 3 in the 12h column will budget a crew member for 3- 
12 hour days. OT and Fringe values are automatically calculated based on the Fringe setting 
assigned to each Account.  
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    •  Rate  - Rates can be entered directly, at the present Currency. Changing the Currency setting 
will convert all values in this column. (see also: Currencies)  
    •  OT Base - Available in Crew (Manual OT) type Categories. Enter the base-day hours which 
will be used in OT calculations  
    •   1.5x, 2x - Available in Crew (Manual OT) and Talent type Categories. Enter the number of 
hours of OT at each rate.  
    •   Fringe - Displays the calculated Fringe amount.  
    •   Phase Total  Phase Total column headers will display the Phase Name. Note that values can 
be entered directly into this column.  
  
The Detail List 
 
Any Detail items entered for the active Account/Phase are visible in the Detail List. You can adjust 
the size of the Detail List by dragging it's title bar. The Detail List can be shown or hidden by 
clicking the Detail Button located at the upper-right corner of the Budget tab. You can add, edit and 
delete Details by using the buttons under the list. Ctrl-clicking (right-click in PC) will display a 
popup menu of possible actions. (see also: Details)  
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The Main Tab Panel 
 
 
The Purchase Order Tab 
 
This tab contains the Purchase Order List. From this list you can add, edit and delete POs using 
the buttons displayed below the list. Double-clicking an item will open it in the PO Edit Window. 
The Total column displays the sum of all cost items held against each PO. Items may be sorted by 
clicking in any column header. 
  
 Printing the PO List 
 
To print the Purchase Order List on the currently selected printer, click the Print button below the 
list. 
 
For more information on working with Purchase Orders, see:  Features/Purchase Orders.  
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The Main Tab Panel 
 
 
The Petty Cash Tab 
 
The Petty Cash Tab consists of three elements - The Petty Cash Envelope Log, the Petty Cash 
Distribution List and the PC Master Summary. You can add, edit and delete PC Envelopes by 
using the buttons located under the Envelope List, or by Ctrl-clicking (right-clicking in PC) on an 
Envelope.  
 
There is one special Account named COMPANY. This Envelope represents the production 
company itself or the source of cash for the production. Typically, a production manager would 
transfer money from the company Account to his Envelope, then distribute cash to the other 
Envelopes. The company Account can be displayed by clicking on the Company button. 
 
The Master PC Distribution List summarizes all PC in the budget by Account.  
 
To learn more about using PC Envelopes, see:  Petty Cash.    
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The Main Tab Panel 
 
 
The Calendar Tab 
 

The Calendar Tab allows you to conveniently keep a production schedule along with your budget. 
The calendar is a very simple text-based one intended for simple one-step entry. It is not meant to 
compete with sophisticated stand-alone calendar applications. You can print calendars in a variety 
of formats. You can even print calendars that span months to accommodate lengthy production 
schedules. 
  

Navigating the Calendar Use the scrollbar on the right side of the calendar to move to a particular 
date. To see more weeks at once, adjust the zoom slider under the calendar. 
 
  

The Event List 
 

You can see all events in list form by clicking the List button at the lower right. When events are 
selected in one view, they will also highlight in the other view. 
 
  

Adding, editing and deleting events To add an event, double-click on any date in the calendar 
view. Enter the text and click the OK button. To edit an existing event, double click on it in either 
view. Likewise, an event may be deleted in either view: highlight it, then press the Delete key. 
 
  

Moving Events To move one or more events, first highlight them in either the Calendar or List, 
then click on the Move button. Enter the number of days forward you would like to move the 
events. You can move events to earlier dates by entering negative numbers (use the “minus” 
symbol, not parentheses). If the specified move would result in one event overlapping another, the 
move will not be performed. 
 
  

Printing the Calendar To print the calendar, click on the print icon in the toolbar or choose 
File/Print from the main menu. Click the Calendar tab. Select the desired options and click the Print 
button. 
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The Main Tab Panel 
 
 
The Detail Browser Tab 
 
 The Detail Browser provides an overview of budget detail not possible in other lists. Note that the 
Details presented in this list are the same Details displayed for individual Accounts in the Detail List 
on the Budget Tab. Here they are displayed for all Accounts at once. Details can be added, 
deleted or edited directly from the browser by using the buttons under the list, or by Ctrl-clicking 
(right-clicking in PC) on an item in the list. Keep in mind that when entering items from the Detail 
Browser, it is important that you correctly select the target Account and Phase from the Account 
popup on the Edit Detail Window.  
 
You can select which Phase's items will display by selecting from the small Phase popup menu 
under the list. If an actual type phase is selected, several Detail Type buttons will appear to the 
right of the popup. These buttons allow you to display any combination of Detail types. Note that 
they are “toggle" type buttons; that is, pressing them alternately hides and shows the 
corresponding Detail types. The rightmost button functions as an All/None button.  
 
The list can be sorted by clicking on any column header. 
  
Filtering the display 
 
 Results can be narrowed by using the Filter feature. First click on cell you want to use as criteria. 
For instance, to see only items for a certain vendor, click on that vendor's name in the Name 
column. The Filter button's caption should now indicate the column you clicked in. Click the Filter 
button to display the filtered results. The heading over the list will indicate the filtered state of the 
list. Note that the Total column now displays the filtered total. To restore the full display, click the 
Filter button (now labeled as “Un-Filter”).  
  
Printing from the Detail Browser  
 
You can print the results to the current printer by clicking on the Print button. 
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Application Preferences 
 
 
The Preferences Window can be opened in Windows and Mac Classic by selecting 
Tools/Preferences from the Main Menu. Under OS X, use the Showbiz Budgeting/Preferences 
menu. Application Preferences are saved between sessions and affect all open budget files. 
 
Underline totals containing detail - Checking this Preference will cause all total values displayed 
in the Budget Grid to appear underlined when the value is derived from one or more Detail Items. If 
the Detail List is not visible, double-clicking on the underlined value will display it.  
 
Measurements in Centimeters - Controls units of measurement which are used when displaying 
the Print Ruler.  
 
Use ‘Flash-Fill’ – Check this box to auto-complete vendor names as you are making Detail 
entries.  
 
Auto-Save every 5 minutes - Minimize the potential for lost work in the event of a power failure by 
checking this Preference.  
 
Use 'Section' and 'Line' nomenclature - If this option is checked, Categories will be referred to 
as 'Sections' and Accounts will be referred to as 'Lines'.  
 
Warn if budget is in use – Checking this option will insure that you are aware if someone else on 
your network has a file open at the same time that you are accessing it. 
 
Screen Font - Click this button to select the font which will be used in all lists and grids. Note that 
this is not the font used in printing. To select the printing font, select File/Print from the main 
menu, then click the Font button.  
 
Phase Colors - This horizontal slider control allows you to adjust for variations in monitor display 
settings and screen types which can cause the default Phase colors to appear too faint.  
 
Open last budget on startup – Permits you to determine whether the program will open with no 
file displayed, or with the most recently open file displayed. 
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Budget Preferences 
 
 
The Preferences Window can be opened in Windows and Mac Classic by selecting 
Tools/Preferences from the Main Menu. Under OS X, use the Showbiz Budgeting/Preferences 
menu. Budget Preferences affect only the current budget. 
 
Display cents in Currency amounts - Displays two-digit precision Currency amounts in the main 
budget grid.  
 
Require Detail on estimates - Prevents the direct entry to the main budget grid for estimated type 
Phases. Checking this option will maintain consistency with other long-form applications that do 
not allow non-Detail entry.  
 
Require Detail on actuals - Prevents the direct entry to the main budget grid for actual type 
Phases. In order to provide more meaningful reports it is recommended that all actuals be entered 
as Detail items.  
 
Warn on duplicate invoice numbers – Prevents duplication of the same invoice number.  
 
Suggest Fringe settings when adding detail - This feature will automatically assign the Account-
level Fringe settings to each new Detail item.  
 
 The following settings are form-specific and should never need resetting after initial form design: 
 
Account totals include fringes - If this Preference is checked, Fringe amounts for each Account 
will be calculated into the displayed Account totals. Unchecking this Preference will post a Fringe 
subtotal for the entire Category at the bottom of each Category.  
 
Sort Category Codes numerically - Sorts Category Codes in numerical, rather than alphabetical, 
order.  
 
Show movie-style Summary recaps - Provides above-and-below-the-line type recaps which are 
common in long-form budgets on the Summary page. 
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What are Views? 
 
 
Views are a powerful feature which controls how a budget's Phases and columns are displayed. 
Each View controls the following display properties:   
    • The visible/hidden state of Phases  
    • The collapsed state of Phases  
    • The visible/hidden state of columns  
    • The relative widths of the visible columns  
    • The column order  
    • The visible/hidden state of the Variance and Variance % columns  
  
 
Any number of Views may be defined, named and stored within a budget or Template. Combined 
with the Phase feature, Views make possible distinct task-specific work environments, i.e., 
budgeting, actualizing, Currency comparison, Phase comparison, etc. 
 
Any View can be printed, enabling a form-designer to create Views which closely match a specific 
paper form in appearance. Views can be fully or partially locked to protect them from changes. This 
is important where it is desirable to maintain a visual consistency with an existing paper form.  
 
To select which View is active, simply select one from the View popup menu on the Budget or 
Summary tabs. 
 
Views can be edited, added, or deleted at anytime by using the View Manager Window.  
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The View Manager 
 
 
The View Manager allows you to add, delete and modify Views. To display the View Manager, 
select View/View Manager from the main menu, or click on the Views icon on the toolbar. The 
Views contained in the current budget are displayed in the listbox on the left side of the Window. 
View properties are edited on the right side of the window. 
 
To add a new view to the current budget: 
   
    •  Click the Add button under the Views List  
    •  Name the new View in the View Name field  
    •  Move the View to the desired order in the list by click the Up and Down buttons  
    •  Modify the View settings  
    •  Click the OK button.  
 
To modify a View: 
  
    • Click in the list on the View you wish to modify. The View's properties will appear on the right 
side of the View Manager Window.  
    • Select a Category Type from the Category Type pulldown list. Settings will affect all categories 
of the selected Type.  
    • Adjust the overall visibility of each Phase by checking the box next to the Phase name. This 
setting affects the visibility of this view across all Category types and has the same effect as 
“Show” settings made from the main View menu.  
    • Adjust the visibility of individual columns within each visible Phase by checking the box next to 
the column name. If column names are not displayed, click on the disclosure symbol to do so. 
Note: The purpose of the disclosure symbols is to offer easier navigation within the list. They do 
not affect the visibility of the columns. To hide a column, you must uncheck the appropriate 
checkboxes for each column.  
    • Choose the visibility of the Variance columns  
    •  Set the lock mode of this View. It is recommended that standard Views used for printing be 
locked. If you need to make further adjustments like columns widths, you may wish to leave this 
View unlocked for now since the View Lock mode can be easily changed later from the View 
menu.  
 
Other view-related settings can be adjusted on the main Budget Grid: 
   
    • The relative columns widths  
    • The columns order  
    • The Collapsed Phase states  
 
After making adjustments on the Budget Grid, set the Lock mode for this View by selecting 
View/Lock from the main menu 
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Resizing Columns 
 
Virtually all columns in Showbiz Budgeting can be resized. If column-sizing is active, then the 
mouse cursor will change to a resizing cursor when passed over a column-header border. If there 
is no column-header, as in the Titles area, then the cursor will indicate resizing in any row. 
Changes made to column widths only affect the currently selected View, and the current Category 
type.  
 
Note: If you cannot resize the columns in the main budget grid, it is because the current View is 
locked. To resize columns in this case, you must first select View/Lock/Unlock from the main 
menu. It is recommended that any View used for printing remain locked to prevent accidental 
changes.  
  
 There are three resizing 'modes'.  
 
 Adjacent columns - this is the default mode. Only the columns immediately left and right of the 
cursor are resized.  
 
 All Right - Enter this mode by holding down the Option key on Mac or the Alt key on Windows 
while using your mouse pointer. In this mode, all columns to the right of the cursor are resized 
proportionally.  
 
 All Left - Enter this mode by holding down the Shift key while using your mouse pointer. In this 
mode all columns to the left of the cursor are resized proportionally.  
    
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



June 3, 2010 v8.72 

 

34 

The Currency Window 
 
 
To display the Currency Window, select Tools/Currency from the main menu or click on the 
Native Currency icon on the right side of the toolbar. 
 
The Currency window allows you to store up to ten Currency exchange rates, names and symbols. 
Your "home" Currency would typically have an exchange rate of “1”. 
  
Entering Currency Symbols 
 
Entering Currency symbols from the keyboard differs according to your operating system and 
country. Below are a few examples for US keyboards. Note that in Windows you must hold down 
the Alt key while typing the indicated numbers on the Numeric Keypad. 
  
    • Euro: Mac: Option+Shift+2;  Win: Alt+0128  
    • Yen: Mac: Option+Y;  Win: Alt+0165  
    • British Pounds: Mac: Option+3;  Win: Alt+0163  
  
Making a Currency active 
 
Clicking the radio button next to any exchange symbol makes it active. When an exchange rate is 
active, all 'Rate' values in all Phases will be multiplied by the new rate for display. You may freely 
make entries at the new exchange rate providing that you enter in the new Currency units.  
  
Displaying In Native Currencies 
 
Each Phase has a native Currency setting. Checking the 'Display In Native Currencies' checkbox 
will cause all Phases to display in the native Currency defined for that Phase. This feature can be 
useful for displaying a side-by-side budgets in two or more currencies. (see: Comparing 
Currencies for more information) 
  
Displaying Currency Symbols in the Budget 
You can display the active Currency symbol next to the Phase Total Column Header by checking 
the 'Display Symbols' checkbox. This is recommended at all times. 
  
View current exchange rates 
If you have an internet connection, clicking on the View Current Rates button in the Currency 
window will open your browser and connect you to a currency exchange site. 
 
Comparing Currencies 
 
Showbiz Budgeting allows you to create special Phases and Views for displaying side-by-side 
comparisons of the same budget in two or more Currencies. Once these are created they will be 
stored with the budget for future use. If your budget does not already have a Currency comparison 
View, follow these steps: 
   
    • If you haven’t already done so, make sure you have defined the necessary Currencies and 
rates and make sure "Display in Native Currencies" is checked. (see: The Currency Window)  
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    • Click the Phase icon on the toolbar to open the Phase Manager. Click the Add button. Enter a 
name for the Phase. This name will be displayed in the column header. Enter the same name as 
the Phase you wish to convert, i.e., "Total" or "Estimated".  
    • Select the Currency for this Phase   
    • Select type "Sum of Estimated Phases" or "Sum of Actual Phases" as appropriate. In the 
Included Phase listbox, check only the Phase you wish to convert.  
    • Select Don't display   
    • Click OK.  
    • Click the Views button in the Toolbar. And add a new View named "Conversion". In the 
columns listbox, put a check next to each of the new Phases you wish to display. Click the OK 
button. 
 
 Tip: You can quickly collapse your display to Totals columns only by pressing Shift-~ or selecting 
View/Collapse Phase from the main menu. 
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Using Globals 
 
 
Showbiz Budgeting's powerful "Globals" feature is a time saving tool that allows you to quickly 
replace commonly used values, permitting quick large scale changes or to audition any number of 
'what-if' scenarios. After a Global is defined, you can assign the Global to most Quantity fields with 
a single key stroke. When you change the Global definition, the budget will be recalculated to 
Account for the changes. If your budget contains any Short-Form Crew sections, you will be able to 
define the number of days of each length. For instance, you can define a Global called "Shoot" as 
three 10hr days and two 12hr days. 
  
 To define a Global:  
   
    •  Click on the Globals button on the toolbar or Select Tools/Globals from the main menu. The 
Globals window will appear.  
    •  Click Add. A new, blank Global will appear  
    • Enter a simple Code in the Code field (“S” for “shoot”, for instance).  
    •  If there are no Short-form Crew Categories in your budget: simply enter the value in the 
Value column.  
    •  If there are Short-form crew categories: enter the number of days for each day-length. 
These values will be used in crew Accounts. If you click in the ">>>" column so that a bullet 
appears, then the Value field will contain the sum of days. This is the value that will be used in 
non-crew Accounts. In this way you can use the same Global for crew and non-crew Accounts.  
  
To assign Globals: 
   
    • In any Quantity field, type the first letter of the Global's Code, or Ctrl-click (right-click in 
Windows) to select from a contextual menu.  
    • In Short-form Crew type sections, a special "Global" column is provided and works similarly.  
 
To remove a Global assignment, simply press the backspace key or space bar when your highlight 
is in the column in which the Global was entered. 
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Using Accumulators 
 
 
Accumulators provide a way to calculate a subtotal of selected Accounts for use on the Summary 
page. Accumulator results can be targeted in 'contract fee' Summaries. Examples of uses for this 
feature are markups, taxable items, GST, discounts, etc. Accumulator support can be set up on a 
per-Category basis. 
  
General Use 
 
Each Accumulator can display a column in the Budget Grid when appropriate. Placing a bullet in 
the column for any Account will cause the Account amount to be included in the result. You can 
press any character key to place a bullet or use the space bar to clear a bullet. 
During routine budgeting, you will usually only be concerned with bulleting desired Accounts, and 
setting the associated fee percentage in the Summary. Click the button to the left of the Summary 
Row to set the fee percentage.  
  
Advanced Use 
 
The following steps are normally performed only when designing a Template 
 
Up to three Accumulators are available for use. In order to use Accumulators in a budget, you must 
do the following: 
   
    • Setup the Accumulator Code(s)  
    • Enable Accumulator support in appropriate Categories  
    • Display the Accumulator columns where desired  
    • Target the Accumulator result for use on the Summary page  
    • Set the fee percentage for the project  
  
 To setup the Accumulators:  
   
    • Select Tools/Accumulators from the main menu to open the Accumulators Window  
    • Type a Code and a description for up to 3 Accumulators. Example: TX, Taxable  
  
 To enable Accumulator support in any Category:  
   
    • Click on the Budget Tab, and select the desired Category.  
    • Select Category/Edit from the main menu.  
    • Under Optional Support, check the box next to the Accumulator(s) you wish to enable.  
    • Click the OK button.  
  
 To display the Accumulator column(s):  
   
    • From Budget tab, use the View pulldown to select the desired View.  
    • Click the View button on the toolbar  
    • For each section Type in your budget, place a check next to the desired Accumulator Code  
    • Click the OK button.  
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 To target the Accumulator result(s) in the Summary:  
 
    • Click on the Summary tab  
    • To target an Accumulator in an existing Contract Fee line, select the row then press Ctrl-E to 
edit; otherwise, press Ctrl-A to add a new Summary line.  
    • Select the type of Contract Fee if not already selected.  
    • In the target list, place a checkmark next to the desired Accumulator  
  
 To set the Summary fee percentage:  
   
    • Click the gray shaded button at the left side of the desired Summary line to open the Summary 
Fee entry form. 
 
You may enter either a percentage or a flat amount for the Estimated, Working  and Actual costs.  
Use the “%” checkbox to establish whether the number entered is a percentage.  If it is left blank, 
then Showbiz Budgeting will use the figure as a flat amount.  Click the OK button when you have 
completed entering the info in the form. 
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Using Breakouts 
 

 

The Breakout is a tool that allows you to keep an independent total of specific portions of one or 
more Details. Three Breakouts can be created for both the estimated and actuals Phases. 
 
To create a new Breakout: 
 

1. Open the program and your budget file. 
2. Click the Tools menu and select the Breakouts option. The Breakouts window will be 

displayed. 
3. Select the Phase (estimated or actual) from the dropdown list that you want like to create 

the Breakouts for. 
4. Enter a unique name in the Breakouts’ name fields. 
5. Click the OK button to close the window when you are done. 

 
 
When you are entering a Detail a part of which you would like to include in a Breakout, click the 
Breakouts button at the right side of the Edit Detail window to display the three Breakout fields. 
Enter the complete calculation for your Detail as you normally would and then enter the “broken 
out” portion of the amount into the relevant Breakout field.  
 
You can print a report which lists all of your Breakouts from the Other Reports tab in Budgeting’s 
Print window. 
 
Breakouts can be used as the basis of Contract Fee calculations in the Summary tab. Use their 
checkboxes in the ‘Target for percentage calculation’ list in the Edit Summary window to select 
them.  
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Using Sub-Groups 
 

 

Sub-Groups allow you to assign Details to specific groups which can be included in or excluded 
from your budget. You can isolate costs for particular scenes, locations or other factors unique to 
your project or you could use a Sub-Group to identify those costs which are used as the basis of 
production incentives offered by various states. 
 
The program contains one default Sub-Group, ‘Unassigned Items’. All amounts entered into your 
budget are included in this unless you assign them to another Sub-Group.  
 
To create a new Sub-Group: 
 

1. Open your budget file and click the Sub-Groups icon. The Sub-Groups window will be 
displayed. 

2. Click the ‘ + ‘ button and the Add Sub-Group window will be displayed.  
3. Enter your Sub-Groups’ name into the Name field and click the OK button. The new Sub-

Group will be added to the list in the Sub-Group window. 
4. To delete a Sub-Group, highlight it in the list and click the ‘ – ‘ button. 

 
All Sub-Groups are included in your budget by default. 
 
Once you have created one or more Sub-Groups, you can assign Details to them by clicking in the 
Sub-Group checkbox in the items’ Edit Detail window. De-select the checkbox when you want to 
remove the Detail from a Sub-Group assignment. This will put the Detail back into the Unassigned 
Items Sub-Group. 
 
To exclude a Sub-Group from your budget, open the Sub-Group window and click in the Exclude 
checkbox next to the Sub-Groups’ name. To exclude all Sub-Groups from your budget, click the 
‘matchstick’ icon in the Sub-Groups window. 
 
Having your Summary tab selected when you exclude Sub-Groups is the easiest way to observe 
the effect of removing the assigned items from your budget: the amounts in the columns for each 
Phase will be updated to reflect having excluded the assigned items. 
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Using Formulas 
 

 
Formulas can be created on any Account line in the Budget tab: 
 
 

1. Open your budget file and click on the Budget tab.  
 
2. Select the Category in which you want to create the formula from the Category dropdown 

list at the upper left of the Budget tab. 
 

3. Highlight the line on which you want to create the formula. 
 

4. Click the Tools menu, then select Formula. The Edit Formula window will be displayed. 
 

5. In the top field, create a range of Accounts which are to be summed. For example, to sum 
Accounts 193 through 196 in Section I of an AICP commercial file, enter ‘193:196’.  

 
6. Enter the percentage to be calculated against the sum in the Percentage field. Negative 

numbers can be used by adding a minus sign to the number, ‘-50’, for example. 
 

7. Click the OK button to close the Edit Formula window and the result of the calculation will be 
displayed in the lines’ Total column. 

 
 
To remove a formula: 
 

1. Highlight the Account line and click the Tools menu and the Formula option. The Edit 
Formula window will be displayed.  

 
2. Click the Clear button and the calculation will be deleted from the line. 

 
3. Click the OK button and the Edit Formula window will close  
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Detail Items 
 
 
Any Account within a budget may consist of either a single lump sum (“flat”) amount entered from 
the main budget grid, or one or more Detail Items entered from the Detail List. You can display the 
Detail List by clicking the Detail button above the Budget Grid. Detail Items can be added, deleted 
and edited using the buttons below the Detail List. Uncheck the Sort box to the right of these and 
use the up/down arrows next to it to re-order the Details in the list.  
 
The Edit Detail Window 
 
The Edit Detail Window is the primary form used for adding and editing estimated or actual Detail 
items. 
 
Phase - You can select which Phase the item belongs to. When adding new items, this control will 
default to the currently active Phase, so there is usually no need to adjust it. 
 
Account/Line - Select the Account/line for this item. In addition to using the pulldown menu, you 
can type the Account Code. When you tab off the field, the rest of the Account name will be filled 
in. 
 
The following three fields are available for Actuals only: 
 
Date - Must be either a valid date or blank. Enter any format date as specified in your OS’s 
regional settings. Single numbers entered are assumed to be the day of month.  
 
ID - ID can vary according to transaction type (check, purchase order, credit card, invoice, petty 
cash). If entering a petty cash item, the ID must be a valid Envelope Code. (selectable from the 
pulldown menu) 
 
PO Num - Purchase Order Number. You may enter a number or select from the pulldown menu. 
You can create a new PO 'on the fly' by selecting or entering the word "New". 
 
Name - Enter a vendor or employee name here.  It will be displayed in the Vendor column of the 
Detail List.  
 
Description - Enter text here which indicates what goods or services are being budgeted or paid 
for. 
 
Qty - Quantity.  Enter a number here which describes how many of what is in the Unit field are 
being calculated. 
 
Unit - The basis of measurement used to calculate the Detail’s Sub-Total.  Default Units include 
hours, days, weeks, months, years and each; these will be autocompleted when you enter the first 
letter of their name. 
 
Mult - An additional number you may employ to produce a calculation can be entered here.  For 
example:  40 (Qty)  Hours (Units) @ $20 (Rate) X 2 (Mult). Mult is set to a default value of ‘1’. 
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OT Amt - A flat dollar amount may be entered here; however, it will be overwritten if you use the 
OT Helper function (read about it below). 
 
Rate - Amounts in this field are displayed and entered in the active Currency. 
 
Sub-Total - You may enter a number directly into this field if desired. In this case, the amount will 
be copied to the Rate field and Qty will be set to 1. 
 
Fringe % - You may enter either a simple percentage or a Fringe Code. Note: If a Fringe Code is 
assigned, this item will be dynamically linked to the Fringe settings assigned. Changes in Fringe 
Settings will affect all linked Detail Items. Use caution! 
 
Assigned Fringes - You can assign multiple Fringes to this item by clicking the Assign Fringes 
button to view the list of available Fringes in your budget.. 
 
Breakouts - If Breakout fields are hidden, click the Breakouts button to display them. You may 
enter amounts into any of the three fields. (see:  Features/Breakouts for more information) 
 
Repeat Last - You can copy most of the fields from your previous entry by clicking this button. This 
is useful for entering payroll items where much of the data may be duplicative. 
 
Overtime Calculator – Base Hours / 1.5x / 2x / 3x / OT fields 
Use these fields when you want to calculate overtime for a person paid on a daily basis. Enter the 
number of hours on which their daily rate of pay is based into the Base Hours field. The number 
entered into the Rate $ field will be divided by this number to calculate their rate of hourly straight 
time pay. Then enter the number of hours for which they will be paid time-and-one-half, double-
time and triple-time into the 1.5x, 2x and 3x fields respectively. You will see the calculation update 
automatically as you enter the numbers and tab from one field to the next. The result of the 
calculation will be displayed in the OT field and included in the number displayed in the Total $ 
field.  
 
OK - Pressing the Option key (Alt key in Windows) will change the OK button's caption to Next, 
thus allowing immediate entry of the next item, without closing the window. 
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What Are Phases? 
 
 
Phases are one of Showbiz Budgeting's most powerful features. With Phases you can budget 
projects in discrete segments. What those segments represent can vary widely depending on your 
needs. Here are some examples of what a Phase might be: 
   
    • A budgeting mode, i.e., Estimated, Working or Actual  
    • Part of the project in different locations, i.e., Europe, US or Asia  
    • A time period, i.e., June, July or August  
    • A comparative budgeting philosophy, i.e., High, Medium or Low  
    • Currency conversions, i.e., One budget can have Dollar, Euro and Yen columns  
 
  
Summing Phases 
 
Summing Phases calculate and display the sum of other Phases, Using Summing Phases you can 
create a budget with several Phases, then combine all the related Phases into one total. So a “see-
the-world” movie may have the following Phases: 
   
    • Italy, Germany, France, Total Europe  
    • LA, Miami, New York, Total USA  
    • China, Japan, Taiwan, Total Asia  
 
You can change which columns are visible in each Phase by adjusting the current View settings, 
making possible an unlimited number of formats. For instance, in the above example, you could 
create a View which shows only the sub-totals for each region and the grand total. Your columns 
could look like this: 
   
    • Total Europe, Total USA, Total Asia, Grand Total  
 
Lastly, a Phase can have its own Currency setting, so you can create several Phases to display 
the same totals in different Currencies and display them in adjacent columns. 
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Using the Phase Manager 
 
You can display the Phase Manager in any of the following ways:  
   
    • Click the Phase button on the Toolbar  
    • Select Phase/Phase Manager from the main menu  
 
Phases contained in the current budget are shown in the listbox in the order in which they will be 
displayed. Summing Phases, if any, are displayed in bold text. 
  
Changing the Phase display order 
 
You can change the order in which Phases are displayed in the main budget grid by first selecting 
the Phase to be moved in the listbox, then clicking the Up and Down buttons.  
  
Creating and editing Phases 
 
To create a new Phase click the Add button. To edit an existing Phase, double-click on the Phase 
name in the listbox, or click on the desired Phase, then click the Edit button. When the Edit Phase 
window appears:  
   
    • Enter a Name that will appear in the column header  
    • Select the Native Currency for this Phase  
    • Select the Type. Estimated and Actual are primary Phase Types that support data entry. 
Summing Phases are for totalizing or converting other Phases.  
    • If this is a Summing Phase, check the Phases you want included in this Phase. Checking all of 
them will automatically include any new Phases as they are added.  
    • Select where you want to display this Phase. If you are not sure, just select “Don't display”. 
You can always display or hide Phases later using the View Menu.  
 
Tip: You can open the Phase Edit Window for any Phase directly by double-clicking on any Phase 
Total column-header from the budget grid. This is handy when you want to change a Phase Name 
or Currency setting. 
  
Deleting Phases 
 
Phase can be deleted by first selecting a Phase in the listbox, then clicking the Delete button. Note 
that Phases which are being used may note be deleted.  
 
 
 
 
Copying and merging Phases 
 
You may want to copy the values from one Phase to another for various reasons: 
   
    •  To copy Estimated values to a Working or Actual Phase.  
    •  To consolidate various Phases into one Phase. 
    •  To use the current Phase as a starting point for several "what-if" scenarios.  
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When one Phase is copied to another, the existing data in the Phase you are copying to is not 
destroyed. This feature allows you to effectively merge Phases. If this is not the desired result, 
make sure you clear the target Phase before copying.  
  
To copy all values from one Phase to another, follow these steps: 
   
    • 1. On the main budget grid, click in the Phase you wish to copy TO, making it active.  
    • 2. Select Phase/Copy from the main menu.  
    • 3. When the Phase selector appears, select the source Phase, i.e., the Phase you want to 
copy FROM.  
    • 4. Click OK.  
  
To clear all values from a Phase, follow these steps: 
   
    • 1. On the Main Budget Grid, click in the Phase you wish to clear, making it active.  
    • 2. Select Phase/Clear from the main menu.  
    • 3. When the warning message appears, click OK  
 
 
Collapsing Phases  
 
While working in the Budget Grid, you can quickly reduce a Phase to only it's Total column by 
Collapsing it. This is especially useful when working with a large number of Phases such as a 
multi-city or -country budget. These adjustments affect all Category types, for the current View. 
 
To collapse or un-collapse any Phase: 
   
    • In the Budget Grid, click anywhere in the desired Phase to make it active.  
    • Select View/Collapse Phase from the main menu or type Shift-~ on the keyboard.  
 
When a Phase is collapsed, a small red square will be displayed in the upper left corner of the 
Phase Total column header. 
  
Isolating Phases 
 
You can "zoom in" on a Phase even while it is collapsed by Isolating it. When a Phase is isolated, 
all columns selected for display in the current View are revealed and all other Phases are hidden. 
These adjustments affect all Category types for the current View. 
 
To Isolate any Phase: 
  
    • In the Budget Grid, click any Phase to make it active  
    • Select Views/Isolate from the main menu or press the ~ key. Pressing the ~ key again exits 
the Isolated mode. 
When a Phase is isolated, the column headers will display in a darker color to indicate its Isolated 
state. 
 
These features make it possible to work easily with multiple Phases. For example, you can keep all 
Phases collapsed, displaying only totals, then simply hitting the ~ key to work on one Phase at a 
time. 
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Using Fringes 
 
 
Fringes allow you to assign supplementary amounts to any Account or Detail item. Typically, 
Fringes are used to calculate payroll employer liability charges (FICA, Medicare, etc.) but they are 
usable for any situation where you need to add a "premium" to an item. Value Added Tax and 
General Sales Tax are good examples. Fringes can be assigned by Account or Detail items and 
either individually or in groups. In addition to these uses, Fringes also can handle Overtime 
calculations in "Short-form Crew" type Categories. If your budget contains one or more of these 
type Categories, you will be able to enter overtime rates and cutoffs. In this case, assigning a 
single Fringe Code to an Account is like assigning a "Union".  
 
If the Template you are using does not yet have any Fringes, you can easily set them up. Fringes 
settings only need be set up once for a given Template. Once created, Fringe settings are stored 
with the Template for future use. 
  
To create Fringes, follow these steps: 
  
Define Fringes 
   
    • Open the Fringe Manager by clicking on the Fringes icon on the Toolbar.  
    • Click Add. The Fringe Edit window will open.  
    • Enter a Code and Description. Codes must be alphabetical. Short Codes are better, like "U" for 
Union. Tip: If possible, try to begin each Code with a different letter. This will make assigning them 
much easier  
    • Enter percentage amount and cutoff. A Cutoff establishes the maximum dollar amount that will 
be used as the basis for percentage calculations.  
    • Note: Overtime fields will be visible only if your budget contains one or more "Short Form 
Crew" Categories.  
    • Enter each OT level as “X after XXhours” format. For instance, 2X after 12 hours. Overtime 
levels must be entered in ascending order of value (1.5X, 2X, 3X)  
    • Click the OK button. 
 
Important: Fringes can only be assigned in Categories that support Fringes. If you are creating a 
Template or the Fringes columns are not visible, see the section below on enabling Fringe support.   
 
 
 
 
To assign Fringes from the Budget Grid: 
 
Single Codes - The simplest way to assign a single Fringe to an Account is by typing the first letter 
of the Code in the Fringes column. Successive strokes of the same key will cycle through Codes 
beginning with the same letter. An audible "beep" from your computer indicates that no existing 
Code begins with the letter pressed. This method also works if multiple Accounts are selected, so 
you can quickly assign a Code to the entire Category by clicking in the Fringe column header and 
typing a letter key! Assignments can be cleared by pressing the Delete key or space bar.  
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Multiple Codes You can assign multiple Codes by double-clicking in the Fringe column or 
choosing Tools/Assign Fringes from the main menu. When the Assign Fringes window opens, 
check each applicable Fringe Code. 
 
 To assign Fringes from the Detail List: 
 
You can assign Fringes to the selected Detail item(s) by clicking the Assign button. When the 
Assign Fringes window opens, check each applicable Code. 
  
To assign Fringes from the Edit Detail Window: 
 
Single Codes The simplest way to assign a single Fringe is by typing the first letter of the Code in 
the Fringe % field. Successive key presses will cycle through Codes beginning with the same 
letter. An audible "beep" from your computer indicates that no existing Code begins with the letter 
pressed. Assignments can be cleared by pressing the Delete key or space bar.  
 
Multiple Codes You can assign multiple Codes by clicking the Assign button. When the Assign 
Fringes window opens, check each applicable Code. 
  
Enabling Fringe Support 
 
To enable Fringe Support in the current Category, choose Category/Edit from the menu, and 
check Fringe Support. If the Fringes column does not appear in the Budget Grid, make sure the 
current Phase is not collapsed (indicated by a small red square in the Total column header). If this 
is the case, choose View/Collapse Phase from the menu or press Shift-Esc to uncollapse the 
Phase columns. If the Fringes columns are still not visible, click the Views icon in the toolbar and 
make sure that the desired Fringes column is checked as visible.  
 
When enabling Fringe Support it is also important to define how Fringes are displayed in the 
budget grid. (see: Budget Preferences - Account totals include fringes). 
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Using Sync Groups 
 
 

Sync Groups allow you to keep related categories “synchronized”. A typical example is the AICP 
form's "A” and “B” categories. Once categories are assigned to a Sync Group, changes made to an 
account's name, rate or fringe setting will be applied to the corresponding account in all categories 
assigned to the same Sync Group. Note that the term 'corresponding account' refers to the ordinal 
position that the account holds within the category regardless of it's code. So a change to the fifth 
account in a category will be duplicated in the fifth account in all synced categories. For this reason 
only matching categories should be synced. 
  
To set-up a Sync Group follow these steps: 
  
Create a Sync Group 
   
    • On the Budget Tab, navigate to the first Category to be included in a Sync Group. 
    • Open the Sync Group window by choosing Category/Sync Groups from the main menu.  
    • Click the "+" button.  
    • Enter a short name. For instance "AB", or "Crew".  
    • Choose the items you want to keep synchronized - Name, Rate or Fringes.  
    • Choose which Categories should be part of this Group.  
    • Select in which phases you want Synchronization to occur.  
    • Click the OK button  
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Actualizing Overview 
 
When production begins, Showbiz Budgeting provides the tools to actualize your budget. You can 
enter and track:   
    • Checks, Credit Card charges and Invoices.  
    • Payroll, including direct import of actual payroll data from a payroll service  
    • Petty Cash Envelopes, expenditures and transfers  
    • Purchase Orders  
    • Breakouts  
 
When data entry is complete, Showbiz Budgeting's reports make your info look sharp. Reports 
include:   
    • Budget - with Variance and Variance %. You can print any View.  
    • Detail Report - customizable to include selected Phases, pay types, and Account ranges 
subtotaled by Account, pay type, vendor, ID, or PO.  
    • Check Log  
    • Purchase Order Log - with PO's, expense items, or both.  
    • Petty Cash Envelope Log.  
    • Petty Cash Envelope Detailed Report  
    • Petty Cash Spreadsheet  
    • Breakout Report  
  
 
Actualizing Workflow  
 
Note: It is assumed that your budget contains an Actualizing Phase. If it does not, see “Phases” for 
instructions to add one. 
 
Showbiz Budgeting allows you to adjust your actualizaton workflow to suit your personal 
preferences. 
 
The primary objective in Showbiz Budgeting's design is total integration of all expense items, 
making it possible to enter each item only once, yet allow it to be viewed and analyzed from any 
perspective. For instance, if you enter a PO expense for Account 223 on a PO, you can then 
immediately go to Account 223 in the main budget and see the item listed along with all other items 
for that Account. All expenses are displayed whether PC, Invoice, Check or Payroll. No more 
wondering how a total grew to be what it is! 
The primary instrument for expense entry is the Actual Detail Item. Actual Detail Items can be 
entered from various places in the program. Depending on your working method, you can enter an 
expense item from the PO system, the Petty Cash system, the Budget Tab, or the Detail Browser 
Tab. There is no right or wrong way. 
 
Many users prefer to enter all expense items just one way - from the Budget Tab. Simply display 
the Detail List, and click Add for each item. You can mark whether an item is PC, Timecard, 
Invoice, Check or just a Projection. (Marking an unverified item as a Projection is a handy way of 
reminding yourself to verify an item. Just go to the Detail Browser and select only Projection Items 
to see all your unverified items!) If there's a PO number, just enter it. Showbiz Budgeting will allow 
you to enter a PO "on-the-fly" in this way. You need not navigate to the appropriate Account/line 
before entering the next item - simply enter the new Account/line number. 
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 Tip: Hold down the Option key (Alt key in Windows) before clicking the OK button and the OK 
button will become a Next button, so you can proceed directly to the next item. 
 
Working this way may be the opposite of what you are accustomed to, which is entering the logs 
and sending actuals to the budget. Here you are entering data in the budget and the logs are built 
for you. 
 
After entering a few items, click on the other Categories and tabs to see that your items are indeed 
making their way to all the appropriate locations. Petty Cash items are in their Envelopes, POs are 
in the log. The Detail Browser gives you an overview of all items by Type. Lastly, click on the Print 
icon and preview some reports of your creation! 
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Petty Cash Basics 
 
 
The Petty Cash system lets you keep track of PC Envelopes and all PC expenses. You can record 
transactions to and from the production company or between Envelopes. Running sub-totals for 
each Account are always visible and PC expenses are instantly included in the Actuals. 
 
It is important to understand that PC Envelopes contain Actual Detail items. Any item can be 'put 
into' a PC Envelope by entering the Envelope's Code in the PC Envelope field of the Edit Detail 
Window.  
 
 You can put new items into a PC Envelope in two ways:  
   
    • 1. By clicking Add from the Budget Tab's Detail List. When the Detail Edit Window appears, 
click on the Petty Cash option, and select the desired Envelope from the PC Envelope field.  
    • 2. By going to the Petty Cash tab, opening the desired PC Envelope, the clicking the Add 
Expense button.  
 
 To learn more about using PC Envelopes, see: 
   
    • The Petty Cash Tab  
    • Petty Cash Envelopes  
 
 
The Petty Cash Tab 
 
 The Petty Cash tab consists of three elements - the Petty Cash Envelope Log, the Petty Cash 
Distribution List and the Petty Cash Master Summary. You can add, edit and delete PC Envelopes 
by using the buttons located under the Envelope List, or by Ctrl-clicking (right-clicking in PC) on an 
Envelope.  
 
Company  button - There is one special Account named COMPANY. This Envelope represents 
the production company itself or the source of cash for the production. Typically, a production 
manager would transfer money from the company Account to his Envelope, then distribute cash to 
the other Envelopes. The company Account can be displayed by clicking on the Company button. 
 
 The Master PC Distribution List summarizes all PC in the budget by Account.  
 
 To learn more about using PC Envelopes see: 
 
   
    • Petty Cash Basics  
    • Petty Cash Envelopes  
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Petty Cash Envelopes 
 
 The Petty Cash Envelope Window displays the detail of a single PC Envelope. 
 
You can display this window two ways: 
   
    • By double-clicking on an Envelope in the Petty Cash Envelope Log  
    • By selecting an Envelope in the Petty Cash Envelope Log, then clicking the Edit button.  
 
Some notable features: 
 
Code - A unique, short Code for this Envelope. Usually a person's initials. This field cannot be 
blank. 
 
Employee Name, Department - For your reference. 
 
Transaction List - displays all transactions for this Envelope. 
 
PC Distribution List - A breakdown of expenses by Account/line for this Envelope only. 
 
Accountable - The amount of money in this Envelope after all Transfers. For example - if $1000 
was transferred to this department head's Envelope, and $300 was transferred to another 
employee's Envelope, then the Envelopes' Accountable amounts would show $700 and $300 
respectively. The total of all Accountable and Expenditures amounts for all Envelopes equals the 
amount of cash currently out for the project. 
 
Expenditures - The total of all Expense Items for this Envelope, not counting Transfers. 
 
Balance - The cash amount remaining in the Envelope. Negative amounts indicate a deficit  
 
Add Expense button - opens the Edit Detail Window to add an expense item to this Envelope. 
NOTE: Do not enter a PO number in the Edit Detail Window; these are not required and may 
produce confusing results. 
 
Add Transfer button- Transfers cash in or out of this Envelope. You can transfer cash between 
Envelopes or the production company. When transferring cash from or to the production company, 
you may optionally enter a PO Number and a Check Number. 
 
 To learn more about using Petty Cash see: 
      • Petty Cash Basics and The Petty Cash Tab  
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Using Purchase Orders 
 
 
Showbiz Budgeting can help you can keep track of purchase orders, during or after production. 
POs can be entered before you begin actualizing, or they can be entered 'on the fly' while 
actualizing. 
 
With Showbiz Budgeting you can: 
   
    • enter an unlimited number of POs  
    • allow any number of Account/lines on a single PO  
    • hold any number of expenses against a PO  
    • keep current totals for expenses on a PO  
    • print a detailed PO log  
    • print individual POs   
  
About POs and Detail Items 
 
Showbiz Budgeting does not actualize POs themselves. Instead, POs are simply container for 
Detail items, and it is the Detail items held against each PO that are actualized. In fact there is 
nowhere on the PO window to enter an amount! The Total amounts displayed at the bottom of 
each PO are the total of all expense items held against the PO. While this may sound like a two-
step process, Showbiz Budgeting automates the process by filling out the forms for you! 
  
To enter a PO: 
 
You can enter a PO two ways: 
 
1. By clicking the Add button located under the Purchase Order Log. After filling out the Vendor 
fields, click the Add button to enter a Detail item against this PO. Showbiz Budgeting transfers all 
essential info to the Detail item. You simply add the proper Account/line number and a rate, then 
click OK. 
 
2. By entering a new PO number in the PO field of the Detail Edit Window. When you click the 
OK button, Showbiz Budgeting will prompt you to create the new PO, and fill out the PO form for 
you. Just click OK to accept the data. 
  
To delete a PO: 
 
On the Purchase Order Tab, click the Delete button. Only ”empty” POs (defined as those POs 
which have no dollar amount) can be deleted. 
  
 
To edit a PO: 
 
Highlight the PO in the PO Log, then click the Edit button or double-click on the PO in the PO Log.  
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The PO Edit Window 
 
The PO Edit Window allows you to enter a PO as well as view the expense items currently held 
against it. 
 
Some notable fields: 
 
PO Number - This field cannot be blank. You may enter numbers or letters. When adding new 
POs, Showbiz Budgeting will auto-increment the number if possible. 
 
Project - Automatically repeated for each PO. 
 
Vendor - Auto-completes from the current budget or Vendor database 
 
Address - Auto-completes if Vendor field finds a match. Use the Enter key to advance to the next 
line as you are typing in the address. 
 
Also displayed is a list of all expenses currently held against this PO. This list represents the same 
Detail items visible in the Detail List, you are simply viewing them in another window, but in this 
case they are grouped by PO. 
 
You can add, edit and delete expense items directly from the PO Edit Window by using the Add 
and Edit buttons. 
  
 
Printing POs 
 
Note: Before printing POs, you should click the Setup button to configure your company name and 
logo as it should appear on the PO. To print any PO, simply click on the Print button. POs will print 
to the currently selected printer. To determine the current printer, select File/Print from the main 
menu. Printed POs can be timestamped by inserting {TIMESTAMP} into the PO Footer where 
desired from the Add PO/Setup menu.  
 
Detailed PO Reports can be printed by choosing File/Print then clicking the Other Reports tab. 
 
Adjusting Print Margins 
 
While default print margin settings should suffice in most cases, variations in print drivers, 
hardware and personal preferences may require you to make adjustments. 
  
 To adjust print margins: 
 
Open the Page Setup Window by clicking on File/Page Setup, then select a report. 
 
Left, right, bottom and top margins are displayed in the units selected in the Preferences window. 
 
Note: Under the Windows operating system, the Left and Top margins are limited to the margins 
settings which appear in the Printers properties panel. If they are set too large you will not be able 
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to set small margins. To adjust this, select File/Page Setup from the main menu, then click the 
Printer button. 
 
If the printed output is clipped at the bottom or right side, adjust the Height Scaling or Width 
Scaling to a smaller percentage. 
 
 To learn more about printing see: 
   
    • Printing Budgets  
    • Printing Reports  
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Printing Budgets 
 
 
To print budgets or reports, select File/Print from the main menu or click on the Toolbar's Printer 
icon to open the Print Select Window. Click on the Budget Tab. 
  
Budget Tab Controls 
 
Non-zero button - Selects only items for printing that have non-zero totals. 
 
All button - Toggles all reports or none in in the “Select items to print” list 
 
Page Header field - Text entered here will print at the top of each budget page except the Title 
Page 
 
View - You can select any View for printing. Keep in mind that the best results are obtained when 
printing Views which are specifically adjusted for printing use, otherwise text clipping could occur. 
You can make View adjustments on the selected View by clicking the Edit button. 
 
Show contract fee percentages on summary - checking this option will print percentage values 
(if any) for each Contract Fee line in the Summary. 
 
Print Logo - checking this option will Print the selected Logo on the Title Page. Click the Logo 
button to select, position and size your logo. 
 
Phase Spacing - print small spaces between Phases, for a clearer presentation. 
 
Phase Colors – checking this option will enable printing the Phases using the colors displayed on 
your monitor. 
 
Uppercase account names - converts all Account/line names to UPPERCASE for printing. 
 
Hide - Use this dropdown menu to set how aggressively inactive (zero-total) items are hidden. The 
five available levels are:   
    • None - all items printed.  
    • Inactive rates - (Default setting) Unused rate values are hidden. This setting allows you to 
keep rates for all Accounts in the Template, while not cluttering the printed budget.  
    • Inactive Accounts - Only active Accounts will be printed.  
    • Inactive categories/sections - Only active Categories/sections will be printed.  
    • Inactive summary rows - Only active summary rows will be printed.  
 
Embedded Detail - You can print inline Detail for any Phase within the budget itself by selecting 
from this dropdown menu. For regular Detail Reports, see Printing Reports. 
 
Print button - Prints directly to the selected printer. 
 
Preview button - Prints to the Preview Window. 
 
Gridlines - Toggles gridlines on and off. 
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Timestamp - Checking this option will print the time and date of printing at the bottom of the page. 
 
Global Names – Checking this option will allow the program to display the Description (rather than 
the Name) assigned to each Global in printed reports. 
 
Limit Decimals – Checking this option will round currency conversions to two places after the 
decimal in printed reports.  
 
Auto-Fit Text – Checking this option will enable the program to automatically size fonts in 
previewed and printed reports to produce the best legibility on balance with available print area. 
 
Custom Title – This option is only enabled in the Other Reports tab. If checked, an option to 
create a unique report title will be displayed when the Preview or Print buttons are clicked. 
 
Page Setup button - See: Adjusting Print Margins 
 
Fonts button - Use this button to select the font which will be used for all printing. 
 
Logo button - Select a logo to be printed on the Budget Title page. 
 
Lines – Click this option to display controls which permit you to determine the thickness (“weight”) 
of the printed gridlines and their color. 
 
Paging button - Allows adjustments to various options for pagination. Generally, these should not 
need to be adjusted unless you are designing a Template. Note: if possible, don't break within 
Categories - checking this option can prevent unwanted page-breaks in formats such as AICP 
where sections are never split between pages 
  
 
 To learn more about printing see: 
   
    • Adjusting Print Margins  
    • Printing Reports  
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Printing Reports 
 
 
If you have included detail or have actualized your budget, you can print a variety of reports to 
organize and present your data in meaningful ways. 
  
To print reports: 
   
    • Choose File/Print from the main menu or click on the Printer icon in the Toolbar.  
    • In the Print window, click the Detail Report tab or the Other Reports tab.  
  
Detail Report Settings 
 
Phase - You can select which Phase's items to include in the report. If a [SUM] Phase is selected, 
then the report will include items from all included Phases. 
 
Include - only Detail types checked will be included in the report. Non-detail is included for 
completeness - any non-detail (Account level) entries will be included in the report as "Non-Detail" 
amounts. 
 
Sub-total on/and - Items in the report will be grouped and sub-totaled by the fields selected in 
these popups. 
 
Filter - You can limit selection to items that fall between a given range for the fields selected in 
these popups. 
 
 To learn more about printing see: 
   
    • Adjusting Print Margins  
    • Printing Budgets  
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Importing and Exporting 
 
 
You can exchange data between Showbiz Budgeting and other applications. This is accomplished 
by converting data to common file formats which are recognizable by other applications. 
 
Some of the ways this can speed your work: 
   
    • import an entire payroll from your payroll service directly into a Showbiz Budgeting actual  
    • import data from various departments into one complete actual  
    • import and export budgets from other budgeting applications  
    • import and export data between Showbiz Budgeting and your Accounting system  
  
How Showbiz Budgeting Imports Data 
 
Because you may need to merge various files into one budget, Showbiz Budgeting imports all data 
as Detail Items. Therefore, a budget containing nothing but ten non-detailed amounts when 
exported, will contain 10 detail items when imported. 
 
You should also note that all file formats do not support the same fields of data. Showbiz 
Budgeting will generally utilize whatever data is provided. When it is not available, default settings 
will be used. 
 
A few important points to keep in mind: 
   
    • Import/Export functions work on the currently selected budget. When importing, if there is no 
budget open, one will be created.  
    • When importing data into an existing budget, make sure the Account/Line Codes are 
compatible.  
    • Before importing a new file into your budget, you should save a copy it in it's present form, so 
you can restore it in the event that the data is not what you were expecting. You may even want to 
open a new file, then test the import on the empty file. In this way you can see exactly what will be 
imported.  
  
To import or export: 
 
Select File/Import or File/Export from the main menu. The Import or Export window will appear. 
 
Format - For a description of formats see: Import/Export Formats 
 
Default Category Type - when this control is visible, you can select which type of 
Category/column layout will be applied to new Categories as they are created. 
 
Import account names - some file formats contain line names. If you want your budget to adopt 
the new file names check this box. 
 
Target Phase - Select where data comes from or where it's going 
 
Click the Import or Export button to continue. When the Select File Window appears, select a 
filename and click the OK button. 
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Import/Export Formats 
  
IMEX 
 
Showbiz Budgeting's own IMEX format will preserve most data along with PC Envelopes, PC 
transfers and POs. Using the IMEX format you can merge data from several budgets containing 
multiple PC Envelopes, and POs. For instance, one person can actualize PC, and then export it for 
merging into a master actual. If there are duplicate Codes in the files, you can choose whether to 
merge the Envelopes or POs, or separate them using new Codes. IMEX files have a ".umx" 
extension. 
  
Media Services Payroll 
 
Using this format you can import actual payroll data from a payroll service, allowing an entire 
project's payroll to be imported precisely in seconds. You can arrange to receive the file on disk or 
over the internet. Payroll files have a ".ult" extension. 
  

Movie-Magic
7777    and ProductionPro

7777  tab-delimited 

 
Showbiz Budgeting can import budget forms and financial data created with Movie Magic 
Budgeting and ProductionPro Budgeting. In order to do this you must first export a budget from 
these programs in tab-delimited format. Close all budgets in Showbiz Budgeting before importing 
the file so that a new budget will be created. 
 
Note: This import function is intended for easing the conversion of Movie Magic forms and 
ProductionPro templates to Showbiz Budgeting forms. Since vital configuration information is not 
provided in the tab-delimited format, it cannot be relied on for routine import of budgets and 
content.  While the total amounts for your details and accounts will be intact, information such as 
their calculation basis and any applied Globals, Fringes or SubBudgets will not be preserved from 
the original files. 
After importing a budget from Movie Magic or ProductionPro, you must check the settings for 
Summary Contract Fees (referred to in ProductionPro as Floating or Fixed Contractuals). Because 
the tab-delimited format does not differentiate between Level Breaks and Contract Fees, you must 
manually set each Contract Fee row. You can do this by highlighting each Contract Fee Summary 
row then pressing Ctrl-E. Set the Type as Contract Fee. For Target Phase, you should usually 
select "Total of all level breaks". When done, save the budget as a Template for reuse. 
 
 
Point Zero (Actuals) & PowerBid (Actuals) 
 
As these are based on Microsoft’s popular Excel program, the import procedure is similar for both.  
Before importing, a tab-delimited file for each sheet which you wish to import must be created.  To 
do this, open your Point Zero or PowerBid file and click on the tab for the sheet for which you’ll be 
creating a file.  Click File/Save As, give your file a name, select a location to which to save it and 
insure that the “Save as type” is “Text (Tab delimited)”.  Click the Save button.  Repeat this 
process as required for the sheets you wish to import to Budgeting.  Then, open Budgeting and 
create a new file. Being that PowerBid and Point Zero are based on the standard AICP template, 
using the AICP Master template would be a good basis for the new file.  Click File/Import.  Select 
the file format as appropriate to the source file and define your target Phase as Actual.  Click the 
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Import button.  At the next screen, select the source file from the folder in which it was saved and 
click the Open button.  There will be a brief “progress” display, after which you will see that your 
data from Point Zero or PowerBid will have been imported into your new file.          
 
 
 
Showbiz Timecards, Commercial and Feature/TV editions 
 
Using this format permits you to import records from Showbiz Time Cards into any Phase of a new 
or existing budget file.  Before you can import into Budgeting, you must first create an export file 
from Time Cards.  To do so, open  Time Cards and locate the items which you wish to export.  
Click on the Scripts menu and then select Showbiz Budgeting Export. Give your file a name, 
select a location in which to save it and make sure that the File of Type is “Tab-Separated Text 
Files (*.tab)”.  Click the Save button to create the export file.  To bring the info into Budgeting, open 
an existing budget file or create a new one, then click File/Import.  Select Showbiz Commercial 
or Feature & TV Time Cards as the file format and select a target Phase from the dropdown 
menu.  Click the Import button and select the export file you created from the folder to which it was 
saved.  Click the Open button.  If the export file contains account codes that cannot be found in the 
budget to which you are importing, you will be asked to which account you’d like to import the 
records.  The account number you specify will be used only when the imported account codes 
cannot be found in your new file. 
 
JP Morgan Chase Purchasing Card (this format is still in development) 
 
 
 To learn more about import/export see: 
 Importing and Exporting 
 
  
Movie Magic is a registered trademark of Entertainment Partners, Inc. 
ProductionPro is a registered trademark of Set Management, Inc. 
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Importing from Showbiz Scheduling 
 
 
Importing from Scheduling allows you to add items to your budget based on an exported text file 
created by clicking the Export to Showbiz button on the Reports tab in Showbiz Scheduling. 
Although the import is not one hundred percent automated, it will save you a great deal of time and 
effort otherwise expended in manually entering everything. 
 

1. Once you have created the export file, open Budgeting and click File/Import. 
 
2. Select Showbiz Scheduling from the File Format dropdown list and select  the Phase to 

which you wish to import the items from the Target Phase dropdown list. 
 

3. Click the Import button and the Import window will be displayed. Locate your .txt file, click on 
it and then click the Open button.  

 
4. The Import Schedule window will be displayed and you can choose how to group the items 

(referred to as ‘Resources’): None, by Scene or by Category. 
 

5. Click on the first item in the list in the top pane of the Import Schedule window and it will be 
displayed in the lower pane.  

 
6. Highlight the item in the lower pane by clicking on it and then click the Add to Budget at the 

lower left. Budgetings’ Edit Detail window will be displayed. 
 

7.  Assign the item to an account number from the Account dropdown list and enter the other 
relevant factors: Qty, Unit and Rate. Then click the OK button. The item will be added to 
your budget and you can move on to the next item. 

 
 
Contact Showbiz Software Support if you would like assistance the first time you do this. Please be 
ready to provide your export file so we can walk through the process using the same data. 
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Importing from Showbiz Time Cards 
 
Importing from Time Cards allows you to add items to your budget based on an exported tab-
delimited text file created by clicking the Export to Showbiz Budgeting option button in the Scripts 
menu in Showbiz Time Cards. Although the import is not one hundred percent automated, it will 
save you a great deal of time and effort otherwise expended in manually entering everything. 
 

1. Once you have created the export file, open Budgeting and click File/Import. 
 
2. Select Showbiz Time Cards from the File Format dropdown list and select the Phase to 

which you wish to import the items from the Target Phase dropdown list. 
 

3. Click the Import button and the Import window will be displayed. Locate your .tab file, click 
on it and then click the Open button.  

 
4. Click the OK button on the next window displayed. If there are account codes in the import 

file which are not matched by those in your budget file, you will need to select a default 
account to which to import the records. Click the OK button. 

 
5. A confirmation message will be displayed, stating the number of records imported. Click on 

the OK button to dismiss the message.  
 
6. Review the details to which the records were imported. The total amounts imported will be 

correct, but you may find you need to edit vendor names and the calculation basis for the 
details. 

 
Contact Showbiz Software Support if you would like assistance the first time you do this. Please be 
ready to provide your budget and export files so we can walk through the process using the same 
data. 
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Showbiz Budgeting Release Notes 

Key: 

• [fix] = Bug Fix  
• [imp] = Improvement on bug, but problems may still exist  
• [new] = New Feature  
• [chg] = Changes previous functionality  
• [kis] = Known Issue  
• [wrk] = Workaround  
• [nlr] = No longer reproducible, probably as a result of another bug fix  
• [tip] = Insight into design of a feature, suggest possible uses.  
• [dep] = Deprecated  
• [cpt] = Backwards compatibility issue  

 

Ver 8.72 

• [fix] Edit Detail - 'Repeat Last' button now properly repeats SubGroups settings.  

• [fix] Print Select Window - Extraneous 'Subgroups' item removed from Filter pulldown mwnu.  

• [fix] Copy/Paste - Pasting Detail, PC Envelopes or PO's now properly disallowed when budget 

Phases do not match. Failure message clarified.  

• [fix] Pasting Detail items with invalid account codes no longer causes possible crash.  

• [new] Detail Browser - Added column totals for OT Hours and Misc columns.  

• [new] Holding Option or Ctrl button down while launching app inhibits 'Open last budget on startup' 

feature. Useful in case where last budget may be damaged or corrupt.  

• [fix] Last PO in PO Log now prints correctly if selected for printing.  

• [fix] Currency symbol in column headers now update correctly after a change.  

• [fix] Globals now work correctly when editing groups of detail items. 

 

 

Ver 8.7 

• [fix] Support telephone numbers updated.  

• [fix] Breakouts window - changes to breakout names no longer fail to apply  

• [fix] Cost Report - Reports printed from Preview window no longer differ from those printed from 

Print Select window  

• [fix] Use of negative numbers in Edit Detail window no longer cause erroneous fringe calculation.  

• [new] Print Detail Report - Added second subtotal popup menu. This allows, among other things, 

subtotaling by Vendor within Account detail.  

• [fix]Copy/Paste from PO Tab now correctly retains info  

• [fix] Fixed bug which could cause Account names displayed in pulldown on EditDetail window to 

display in incorrect order 
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Ver 8.6 

• [new] New "Lines" button on Print Select window allows line weight and color selection adjustment.  

• [fix] When selecting a PO from the Edit Detail window, the Quantity field no longer erroneously 

resets to 1.  

• [fix] IMEX import and export now properly supports subgroups and extended detail fields  

• [fix] Calendar in Edit Detail window works again  

• [fix] PO Log now sorts correctly by Account and Vendor when "Show POs" is not checked  

Ver 8.4 

• [fix] Fixed bug that could cause unintended fringe amounts in accounts with Special Formulas  

• [fix] Fixed bug that could cause app to lose registration info when switching computer to non-western 

language.  

• [new] When importing from Showbiz PC Envelope, user can now optionally merge data into existing 

envelopes  

• [fix] Improved printing of Cost Reports  

Ver 8.3 

• [new] PO Edit window is now resizable. 

• [new] PC Edit window is now resizable. 

• [fix] Changes made to PO Vendor fields no longer lost if editing a detail item before closing PO edit 

window. 

• [fix] Rate column values now properly converts with Currency setting. 

• [fix] Group Detail edit now properly accepts new value for Unit field 

• [fix] Detail lists no longer draw extra type icon outside list area 

• [new] Holding down shift key on launch skips preferences file-read. This is for diagnotic uses. 

• [fix] Print Logo WIndow no longer displays Logo off center. 

• [new] Vendor Database can now be exported and imported in new XML style format. 

Ver 8.0.0a1 

• [fix] Fixed bug that caused pasted detail to sometimes get posted to incorrect account. 

• [fix] (Summary Edit Window) Fixed bug that caused changes to text or code fields to be lost if a 

category is edited after changes are made.[new] (Import) Can now import from Company 

Move/Showbiz Scheduling applications.  

• [fix] (Open) Fixed bug which could cause app to crash when opening budgets created on a different 

Mac platform. ie. Intel Mac vs PowerPC. 

• [new] Added option to print budgets with phase colors and summary shading. 

• [new] Added Global Math support. Globals can be defined as mathematical expressions of other 

Globals. Globals can now be combined mathematically in the Budget Grid. For instance: ShootDays 

* FeetPerDay.  

• [fix] Fixed bug which could cause app to break if Shift-Clicking in Budget Grid Account column. 

• [fix] Fixed bug that could cause app to break with repeated presses of escape key. 

• [fix] Fixed: Clicking on Name or Account column could sometimes cause Detail List to default to a 

hidden phase. 
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Ver 7.07 

• [fix] (Fringes) Fringe Manager window now remembers size, position and column widths.  

• [new] (PO) Deleting POs from the PO Log now also deletes all associated detail items and transfers.  

• [fix] (Phases) Deleting a Phase while it is isolated no longer causes problems.  

• [new] (Import) Warning is now given when attempting to import a previously imported Media 

Services Payroll file. (Issue#3594)  

• [fix] (Phases) Adding a new Phase no longer causes occasional errors. (Issue #3596)  

• [fix] (Budget) Deleting an Account containing one or more Details no longer causes Detail(s) to 

appear in incorrect Account.  

• [fix] (Budget) Fixed bug which could improperly allow entry of blank account codes. (Issue #3817)  

• [fix] (Detail) Detail items with fractional quantities no longer sometimes display unnecessary digits 

of precision in the budget grid. (Issue#3883)  

• [fix] (Budget) Double-clicking on a value in a Qty column no longer clears the value. (Issue #3850)  

• [fix] (Fringes) Unpopulated Fringe Edit window will now permit data entry when the Totals row is 

selected. (Issue #3914)  

• [fix] (Export) IMEX Export once again exports CRLF end-of-line sequences from all platforms.  

(Issue # 3986) 

• [fix] (PO) Fixed a bug which under certain conditions could cause the application to hang while 

editing a Purchase Order. (Issue # 3985)  

• [new] (Print Select) Added a second Filter feature to Detail Report tab which allows simultaneous 

filtering on two fields.  

• [fix] (Import) Point Zero imports are now more complete and reliable, especially when importing 

Petty Cash and PO logs.  

• [fix] (PC) Double-clicking on a Petty Cash Transfer from a Purchase Order now opens the Petty Cash 

Transfer edit window as expected.  

• [fix] (Printing) Fixed bug which could cause program to crash during printing on the Windows 

platform. (Issue # 3592)  

• [new] (All) New user preference opens the last accessed last budget on startup by default. If desired, 

this preference can disabled in the Preferences window. (Issue # 3983) 


